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Device Set-Up 

The following section will detail the items received and set up procedures for your new FieldLine 

Inc Optically Pumped Magnetometer (OPM) System.  

Package Contents 

Every FieldLine OPM System should arrive with the following contents: 

 

Chassis: 

 

Chassis Power Supply (18V, 8.06A): 

 
EdgeRouter X: 

 

EdgeRouter X Power Adapter (12V, 0.5A): 

 
16 OPM Sensors: 

 

OPM Driver (5/64” Driver): 

 
SMA-BNC Adapter: 

 

Ethernet Cable (x2): 

 
3.5” Floppy Instructional Disc: 

 

Ethernet Cable (6”): 
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Installation Requirements 

● The FieldLine OPM Chassis Power Supply requires 100-240 VAC (50-60Hz), 2.0 A 

● The EdgeRouter X power adapter is compatible with 100-240 VAC (50-60Hz), 0.3A, but 

it additionally is designed to work with 24V passive Power over Ethernet (PoE) on the 

eth0/PoE In port, for compatible systems. 

● The FieldLine OPM system does not need to be connected to an external network, 

however, updates are received via the internet and will need to be loaded onto the 

system locally when they are published. If the system is connected to the internet, it will 

be able to grab the updates seamlessly (when prompted by the user).  

● The user may choose to use the system either with the included EdgeRouter X or by 

directly installing their chassis to their own network.  
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Hardware Overview 

The below section will detail the hardware included with the FieldLine OPM System. 

Chassis Front 

 
Figure 1 - Chassis Front 

The lights on the front from left to right: 

● Indicator LED - Appendix B details the LED color code. 

● 1-16 for each Sensor 

● M for Chassis 

● Power Button - Illuminated blue when power is on. A quick press will turn the system on. 

Press and hold to power off. 

 

Chassis Rear 

 
Figure 2 - Chassis Rear 

The connectors on the back from left to right: 

● Power - wall connector using the included power supply. 

● Data - ethernet connector for network connectivity. 

● Input - analog 5V input port for triggers. 

● Sync - used for Multi Chassis System. Chassis 0 will operate as the primary chassis and 

is determined by which chassis has a TOP sync port that is not populated. To connect 

multiple chassis, connect the bottom port of Chassis 0 with the top port of Chassis 1, 

bottom port of Chassis 1 to top port of Chassis 2, etc.   
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NOTE:  

• The “Sync” port should not be connected to anything other than a FieldLine Chassis. 

However, if connected to a standard ethernet port no damage should occur. 

● Sensor connectors - From 1 to 16 sensor connectors depending on configuration. When 

installing a sensor, it is recommended to screw in the top connector until it makes a 

connection, then fully tighten the bottom, before finishing the top. 

 CAUTION: It is recommended that care is taken when installing sensors. Be sure of 

proper orientation (determined by the key on the sensor). Bent pins CAN happen and will 

prevent a sensor from properly operating.  

 CAUTION: Make sure both sides of the chassis have room to intake and exhaust air to 

manage heat.  
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System Set-Up 

The following section will detail the necessary steps to start the FieldLine OPM System and 

discuss the general layout of the FieldLine Recorder. Please note that if the user desires, the 

entire FieldLine OPM System can be operated via a Python API. Details in Appendix C.  

 

Download the latest version of the FieldLine Recorder at https://download.fieldlineinc.com/ 

 

NOTE: When first installing the latest version of the FieldLine Recorder on a Windows OS, the 

Windows Firewall will force the user to go through several prompts. See Appendix E for 

information on how to install the GUI. If the incorrect prompts are selected issues with updates 

may occur.  

Contact Information 

When opening the FieldLine Recorder for the first time the user will be prompted to fill the 

information seen in Figure 3. 

 

 
Figure 3 - Contact Information 

When a user uploads an error log this contact information will be automatically populated and 

will help FieldLine provide a quicker response. This information will only need to be filled in 

once. To access the “Contact Info” window and make changes go to Settings -> Update 

Contact. 

  

https://download.fieldlineinc.com/
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FieldLine Recorder Layout 

The following section will walk the user through the layout of the FieldLine Recorder. Below is 

the latest FieldLine Recorder (v.1.4.44) in the “unconnected” state (Figure 4).  

 

 
Figure 4 - Unconnected FieldLine Recorder (v1.4.44) 

In the File menu there are the following options: 

● Open File: You can load a previously saved .fif file and replay it. 

● Close File: This option stops the current file from being replayed. 

● Play/Pause: Starts the data stream or pauses it. 

● Record: Opens the Recording Prompt.  

● Copy Fields: Will place the displayed field data in the user’s clipboard as comma 

separated values. 

● Exit: Will close the program 

 

In the Settings menu there are the following options: 

● Configure Chassis: Opens the Configure Chassis window. See Device Discovery for 

more detail. 

● Plot Settings: Opens the Global Plot Settings window. This window will allow the user to 

adjust how many seconds are displayed.  

 
Figure 5 - Plot Settings Window 
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● Sensor Geometry: COMING SOON. 

● LSL Streaming: Initiates LSL Data Streaming. See LSL Data Streaming. 

● Update Contact: Allows users to update contact details. 

● Updates: Opens the Updates dialog box. See Updates section for more detail.  

 

In the Help menu there are the following options: 

● About…: Gives the latest information about the FieldLine Recorder. 

● Event Log: Opens the Event Log Window 

● Upload Logs: Opens the Initiate log upload dialog box. See Troubleshooting for more 

details. 
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Sensor Map and Sensor Configuration Table: 

The below image highlights the left-hand side of the FieldLine Recorder. Note that Figure 6 

below is in the “Fine Zeroed” state. More detailed explanation of the system operation is 

included in the Operating the System section. 

 

 
Figure 6 - Field Configuration Table 
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Network Configuration 

The FieldLine OPM System transfers its data over ethernet. The system DOES NOT need to be 

connected to the internet. Depending on the user's preference, the system can be plugged 

directly into a local area network, or it can be connected using the included EdgeRouter X (or 

any other router possessing a DHCP server). Note the EdgeRouter X is set up at FieldLine to 

operate on the 192.168.2.x subnet. If the user would like to change these settings, please visit 

www.ubnt.com/qsg/er-x for more information. 

 

If a device should have a fixed IP address, then the network administrator should assign a static 

IP address to the device through DHCP using the MAC address. The MAC address will be 

found via a sticker affixed to the rear of the Chassis. Please contact FieldLine for assistance in 

determining the system MAC address. 

 

The system uses automatic device discovery for devices on the local subnet. If the user requires 

manually adding a system, see the Manual IP Configuration. 

 

1. If using a local area network, simply plug the chassis into the wall and continue to the 

Device Discovery Section.  

2. If using the EdgeRouter X, install the ethernet cable connected to the User Computer to 

port eth1 on the router. Install the cable connected to the Data port on the chassis to 

eth2. If additional chassis are present, please use ports eth3, and eth4 as well. An 

ethernet switch can be utilized for larger systems.  

a. If the user wants to have their EdgeRouter X connected to the internet, please 

insert a network cable in port eth0. 
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Device Discovery 

Auto Discovery 

To connect to FieldLine Magnetometers, from the menu bar select Settings - Configure Chassis. 

This will open a dialog (Figure 7) showing all the discovered devices on the local network.  

 

Systems will be grouped by the primary device they are connected to. Notice 172.16.5.167:7777 

is connected to 172.16.5.146:7777 in the below figure and shows (2/2). Whereas 172.16.5.147 

and 172.16.5.166 are not connected and show (1/1). Select the desired device and hit “ok.” 

 

 
Figure 7 - Dual Chassis Configuration Window  
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Manual IP Configuration 

Manual IP configuration may be required in certain network configurations (i.e., chassis is 

located on a separate subnet and auto discovery is unable to detect it). To manually connect to 

a FieldLine OPM System, select Manual in the Configure Chassis dialog box. This will open the 

Manual IP config box seen in Figure 8: 

 
Figure 8 - Manual IP Config 

Toggle over to the Add tab and enter the IP address of the chassis to be added (Figure 9).  

 

 
Figure 9 - Add IP Config  
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Network Error Conditions 

Any Host Chassis will indicate if it is missing secondary Agent Chassis. An agent without a host 

device will show in a Floating category. If either case occurs, verify wiring and network 

connectivity. 

 
Figure 10 - Host Chassis Missing Agent 

 
Figure 11 - Missing Host Chassis 

Figure 12 displays a Disconnect window which will automatically show up in the event of a 

network interruption between the GUI and connected system.  

 

 
Figure 12 - Connectivity Error 
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When a system is selected, the Identify button becomes selectable. Pressing this button will cause 

the chassis LEDs on the selected system to blink yellow to allow for quick visual identification of 

which system the GUI will connect to.  

 
Figure 13 - Identify Highlight 

 

Mismatched Version 

If upon connection the user has two (or more) chassis with mismatched versions a pop up as 

seen in Figure 14 will appear: 

 

 
Figure 14 - Mismatched Version 

To continue the user must update their system. See the Updates section for more details.  
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Operating the System 

The following section will detail how to use the FieldLine OPM System to collect magnetometer 

data.  

Sensor Selection and Control 

Sensors can be selected manually from the sensor map or using the sensor selection text box 

(highlighted in red in Figure 15). To select a sensor using the selection box, simply click with the 

mouse. To deselect, hold the SHIFT key and select the sensor you want to deselect. 

 

 
Figure 15 - Graphical or Text Based Sensor Selection 

The sensor selection text box takes input of the format <chassis list/range>:<sensor 

list/range>;<chassis list/range>:<sensor list/range>. Lists are of the format X, Y, Z and ranges are 

of the format X-Y.  The * character can also be used as a wildcard. Combinations of lists and 

ranges can be used as well. The following list provides some examples of valid selections. 

- *:*  

Will select every available sensor and chassis 

- 0:1-16 

On chassis 0, sensors 1 through 16 

- 0,1:1-4,6,8 

On chassis 0 and 1, sensors 1 through 4 as well as 6 and 8 

- 0:*;1:5 

On chassis 0 all sensors and chassis 1 sensor 5 only 

Sensor selection strings can be saved using the Save… button and then later restored using the 

Load… button. 
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Adding/Removing Channels 

Channels can be added on a per sensor basis or to all sensors at once. Double clicking on the 

sensor name in the Sensors column in the Sensor Configuration Table will bring up the channel 

configuration dialog (Figure 16). 

 

 
Figure 16 - Channel Configuration Dialog 

Currently, the only channel available to add is B_Z, which is the magnetometer output in the 

direction normal to the sensor tip in Tesla at a sample frequency of 1 kHz. Pressing the trash icon 

removes the channel. By checking the Show Plots checkbox, the channels will automatically begin 

graphing after they have been added. 

 

If the same channel is to be added or removed for all sensors, the Quick sensor configuration 

dialog can be used, by pressing the Quick button on the Sensor Configuration Table. 

 

 
Figure 17 - Quick Sensor Configuration 
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As with the single sensor channel configuration, only B_Z at 1KHz is selectable. Note that only 

Fine Zeroed channels will be added.  

 

By selecting the Remove radio button, the specified channel will be removed from all the identified 

sensors. If the user wants to selectively remove channels, the top box can be used to identify 

which are to be added/removed using the same format as the sensor selection box. 

Using the Analog Input 

Every FieldLine system comes included with an Analog Input for a trigger signal from 0-5V. To 

access this trigger, open the Sensor Selection dialog at 00:00, and enable Analog In. This will 

begin streaming the data being received on the SMA input jack. 
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Using the System 

Once a sensor selection has been made, the sensor command toolbar can be used to 

start/stop/zero the sensors. 

 

 
Figure 18 - Sensor Command Toolbar 

The first step to running the system is to verify that the sensors are in a magnetically shielded 

area. The sensors can be “Restarted” (hit the Restart button outside of a shield), however, they 

will not be able to Coarse or Fine Zero in an environment with such large external fields.  

 

Additionally, hitting either the Coarse Zero or Fine Zero button will not perform any actions if the 

sensors have not been restarted. Likewise, sensors must be Coarse Zeroed before they can be 

Fine Zeroed. 
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Sensor Restart 

After verifying the placement, the sensors can be restarted. This is done by hitting the “Restart” 

button seen in the sensor command toolbar figure. Any combination of sensors can be restarted 

at once.  

After hitting the “Restart” button the sensors will begin initializing (the “green check” will become 

an (“orange exclamation point”). They will go through several indicator stages as detailed in 

Appendix B.  

The User will know the sensors have finished initializing and are ready to zero once they are solid 

green and the green check mark has returned. This will be reflected by the indicator lights, and in 

the GUI as seen in Figure 19: 

 

 
Figure 19 - Restarted Sensors 
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Sensor Coarse Zero 

After the sensors have been restarted, they can be coarse zeroed. This step is necessary for the 

system to get the internal offset fields in an appropriate range for operation. The indicator LEDs 

will blink “light blue” during coarse zero, and when complete will display the initial zeroed fields.  

 

See a close up of the Sensor Configuration Table following a coarse zero in Figure 20: 

 

 
Figure 20 - Sensor Configuration Table 

NOTE: If the user wants to save the offset fields they can go to Settings -> Copy Fields and this 

will place a comma separated list of values on the computer’s clip board.  

 

NOTE: If any of the field values are egregiously high (i.e. >150nT) there has likely been an issue 

either in the Field Zero-Ing or that there are magnetic gradients too large to compensate for. 

Please attempt the Coarse Zero again, or if the problem persists, contact FieldLine Support. 

 

NOTE: The user will not be able to stream any data (except the ADC trigger) during the restart 

and coarse zero process. 
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Sensor Fine Zero 

Finally, after Coarse Zeroing the User can select fine zero. This will result in Figure 21 and will 

enable the Bz – Open channel on all sensors that have been zeroed.  

 

FieldLine recommends users to operate the system in the “Closed Loop” configuration. Check the 

“closed loop” box and the sensors will begin to actively compensate for the magnetic field in the 

Z direction. The displayed channel will change to “Bz Closed.”  

 

 
Figure 21 - Fine Zeroed Sensors 

NOTE: If the user wants to save the offset fields they can go to Settings -> Copy Fields and this 

will place a comma separated list of values on the computer’s clip board.  

 

NOTE: If the sensors are removed from the magnetically shielded environment, they will need 

to be re-zeroed and the results displayed WILL not be correct.  
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LSL Data Streaming 

The FieldLine Recorder supports streaming data in the LSL (Lab Streaming Layer) format. To 

initiate go to Settings -> LSL Streaming. This will bring up Figure 22. Once the user hits start the 

dialog will display the number of active channels. To view the LSL channels, you must have a 

compatible LSL viewer and connect to the FieldLineStream name.  

 

 
Figure 22 - LSL Streaming Dialog 
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Recording 

While data is streaming (the “Play” button has been pressed and at least one channel has been 

turned on), pressing the record icon on the menu bar will pop up the recording dialog (Figure 23). 

 

 
Figure 23 - Recording Dialog 

A recording can either be timed or manual. To specify a manual recording do not check the “Timed 

Recording” box. To stop a manual recording simply hit the red record button again. When starting 

a manual recording an estimated file size cannot be calculated. Please note that FIF files have a 

2 GB limit.  

 

Timed recordings can be specified in seconds, minutes, or samples. Based on the sample 

frequency and number of channels running, an approximate file size is calculated. Additionally, a 

miscellaneous info field can be used to store relevant information about the current recording.  

 

FieldLine has introduced a specific naming scheme for recordings. The user must pick a top-level 

folder for the data, and then fill out a Project ID, Subject ID, and Paradigm. The files will then 

appear in a folder directory in the style of: 

 

../{Project ID}/{YYYY/MM/DD}/{Subject ID}/{File Name}.fif 

 

In the example shown in Figure 23, the file would appear at the following path: 
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../Generic ID0/20211115/User 1/20211115_130813_User-1_Generic-ID0_Test-Example-

1_raw.fif 

 

After completing a recording, if the user wants to perform another recording the Figure 24 will 

appear in the red record button is clicked.  

 

 
Figure 24 - New Subject Dialog 

If the user selects new subject the recording dialog box seen in Figure 23 will appear again. If 

the user selects continue subject Figure 25 will appear. Note that the user must change the 

“Paradigm” to be unique. The recorder will not allow for two paradigms of the same name. After 

selecting record, the file will be saved in the same directory structure as the previous file.  
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Figure 25 - Continue Subject Dialog 
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Updates 

FieldLine Recorder updates should be downloaded from the web 

(https://download.fieldlineinc.com). When updates are available for connected devices, the 

update icon  will appear on the menu bar. Clicking the update icon or going to Settings - 

Updates will open the update dialog (Figure 26). The dialog shows the version currently running 

on the device(s) as well as the update version available. If the user does not have internet 

connectivity, please select the “Use local update file” check box. Proceed to reach out to 

support@fieldlineinc.com to acquire the local update file. 

 

 
Figure 26 - Update Dialog showing current and update version 

When the Start Update button is pressed, the update file is downloaded and the update progress 

per device becomes visible. 

 

 
Figure 27 - Update in Progress 

 

https://download.fieldlineinc.com/
mailto:support@fieldlineinc.com
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Upon completion of the update, each device will indicate that the update was successful, and the 

system is ready to continue taking data. 

 
Figure 28 - Update Complete 

Update Failures 

In case of an update failure, all systems should be power cycled, connectivity verified, and the 

update restarted. If problems persist, please contact FieldLine Support.  
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Troubleshooting 

This section covers troubleshooting error conditions. 

Error During Operation 

Errors can occur during operation. If an error is encountered, the user will be notified by the 

flashing red “X” on the status indicator, and the offending sensor’s LED will be rapidly blinking 

the color of the failed stage. Clicking on the status will bring up the “Event Log” (pictured below). 

This will inform the user of the failure code. Refer to Appendix D - Error Codes to diagnose error 

codes. 

 

 
Figure 29 - Error! 

 

 
Figure 30 - Event Log Example 
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Uploading a Log 

 

If requested by support to upload a log, from the menu go to Help - Upload Logs. A brief 

description of the issue can be added to the log upload. 

 

 
Figure 31 - Log Upload Dialog 

After uploading the log, please contact support@fieldlineinc.com with any questions and 

feedback.  

  

mailto:support@fieldlineinc.com
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Safety Notices 

1. Read, follow, and keep these instructions. 

2. Heed all warnings. 

3. Only use attachments/accessories specified by the manufacturer. 

 

 

WARNING: Failure to provide proper ventilation may cause fire hazard. Keep at least 

20 mm of clearance next to the ventilation holes for adequate airflow. 

 

 

WARNING: To reduce the risk of fire or electric shock, do not expose this product to 

rain or moisture. 

 

 

WARNING: Do not use this product in locations that can be submerged by water. 

Sensors are not certified to operate in an aquatic environment. 

 

 

WARNING: Avoid using this product during an electrical storm. There may be a 

remote risk of electric shock from lightning. 
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Appendices 

Appendix A - Revision History 

Rev 1.0 - Nov 2020 (TM): 
- Initial Document Release 

 
Rev. 2.0 - Feb 2021 (TM): 

- Added significant additional detail in all sections. 
 
Rev. 3.0 - Jun 2021 (TM): 

- Updated figures to reflect GUI v1.4.14 
- Fixed a few typos throughout 
- Added Appendix C, renamed revision history to appendix D 
- Added more detail to troubleshooting section, recording section, and sensor selection 

and control 
 
Rev 4.0 - Nov 2021 (TM): 

- Added Contact Information Section 
- Updated GUI Images throughout to reflect latest system (v1.4.44) 
- Added Figure and Table captions 
- Added a Table of Tables and Table of Figures 
- Added LSL section 
- Re-ordered Appendix Names 
- Fixed hyperlinks throughout document 
- Added Appendix E 
- Added FieldLine Logo to Title Page 
- Updated recording section to reflect the latest GUI 
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Appendix B - Indicator LEDs 

 

The LEDs on the front of the chassis are color coded. LEDs can be solid, blinking slow (1 blink/sec), or fast 

(6 blinks/sec). A solid LED means the system is in a specific state, slow blink means a specific operation is 

in progress, and fast blink indicates an error has occurred. Table 1 discusses the meaning of the displayed 

LEDs. 

 

Table 1 - LED Indicator Codes 

Color Speed Sensor/Chassis Meaning 

Blue Solid Chassis Chassis ready 

Blue Slow Chassis Pending finalize of update 

Blue Slow Sensor Fine zero active 

Blue Solid Sensor Fine zero complete 

Light Blue Slow Sensor Coarse zero active 

Light Blue Solid Sensor Coarse zero complete 

Purple Slow Chassis/Sensor Flashing firmware 

Purple Fast Chassis/Sensor Update failed 

Red Fast All LEDs Startup error 

Red Solid Sensor Sensor card present/Sensor disconnected 

White Solid Sensor Sensor card present/Sensor connected 

White Slow Chassis Starting up 

Yellow Fast Chassis Network disconnected 

Yellow Slow Chassis Identify 

Orange Slow Sensor Sensor Start Up Stage 1 

Orange Fast Sensor Failed in Start Up Stage 1 -- Restart the sensor 

Green Slow Sensor Sensor Stabilization 

Green Fast Sensor Failed Sensor Stabilization -- Restart Sensor 

Green Solid Sensor Sensor Start Up Complete -- Idling 

  



37 

Appendix C - Python Software API 

A python API is available to connect with FieldLine Magnetometers. A minimum version of 

Python 3.8.5 is required. After installing the provided .whl file and its dependencies, the API can 

be used to restart/coarse zero/fine zero sensors and start/stop data streams. A separate Python 

documentation and sample code is provided for anyone wishing to use the API. API downloads 

can be found at https://download.fieldlineinc.com/api/.  

  

https://download.fieldlineinc.com/api/
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Appendix D - Error Codes 

Table 2 indicates possible error codes a user might encounter during operation and the potential 

remedy. If any problem persists during operation, please contact support@fieldlineinc.com and 

we will be happy to assist.  

 

 
Table 2 - Error Code Table 

Error 

Code 
Symptom Remedy 

0x3 
Fast blinking white light during initial sensor 

turn on. 

Carefully remove the sensor and check the 

connection between the sensor and chassis. 

If there is no obvious problem, reinsert and 

try again. 

0x63 Fast blinking orange light 

First verify sensor location and temperature. 

If the sensor overheats a failure can 

occasionally be observed in this state. Let 

cool down and try again. 

0x30 Variable stages 

First try restarting the sensor. If the problem 

persists there is likely a configuration 

problem and FieldLine will be required to 

assist. 

0x8 Coarse/Fine Zero Fast blinking light 

Verify the sensors are in a good field 

environment, and there are no metallic 

objects located near the device. After 

remedying, try again. 

0x20 Coarse/Fine Zero fast blinking light 
Sensor lost laser lock during operation. 

Restart sensor. 

 

 

mailto:support@fieldlineinc.com
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Appendix E – FieldLine Recorder Installation 

When first downloading and installing the FieldLine Recorder on a Windows OS Figure 32 will 

appear. Please select “Run Anyway”. 

 

 
Figure 32 - Windows Defender Prompt 

 

Following this prompt, the GUI will begin opening, you will notice a “FieldLine” splash screen 

(Figure 33). This screen will appear every time the GUI is open and will indicate the previous IP 

address that the device attempted to connect to.  

 

 
Figure 33 - FieldLine Splash Screen 

 

Depending on the Firewall settings of the user computer a Windows Security Alert will appear 

(Figure 34): 



40 

 
Figure 34 - Windows Security Alert 

Please select all options (there will occasionally be 3 options). These prompts will be reasserted 

with the installation of new GUIs. FieldLine is currently exploring certifying the GUI as an 

approved Windows application. If the user incorrectly sets the parameters and has trouble 

performing updates, please go to the Windows Defender Settings, select the FieldLine Recorder 

and adjust the permissions.   


